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Notice Date: 17-December-2021
This document lists changes made to CSiPlant since v6.2.0, released 22-March-2021. Items marked with
an asterisk (*) in the first column are more significant.
Analysis
Enhancements Implemented
*
*

Ticket
6588

7371

*

7393

Description
An enhancement has been made to speed up stiffness-formation, event-determination, and
state-update operations during analysis for Pipe elements in presence of many load
patterns. Nonlinear static, staged-construction, and nonlinear direct-integration time-history
load cases for models with many Pipe elements (and many load patterns) should benefit the
most, especially if the analysis time is governed by state update and/or event determination.
The default nonlinear-iteration parameters for nonlinear-static load cases have been
changed by setting the number of constant-stiffness iterations allowed to zero. This will
cause all iterations to use the Newton-Raphson (tangent-stiffness) method. This may be less
efficient for problems with limited nonlinearity, but may be more accurate and even more
efficient for load cases involving friction supports, temperature-dependent behavior, and/or
large-deflections geometric nonlinearity. This change will only affect the default settings for
newly created load cases. Existing models will not be affected. Constant-stiffness iteration
can still be used by changing the iteration parameters of newly created load cases.
Advanced equation solver options "Run Load Cases in Parallel", "Number of (Internal)
Threads Used for Analysis" and "Maximum Size for Response Files (MB)" were made
available on the "Equation Solver Options" form. Running load cases in parallel can
significantly reduce the time it takes to analyze models with multiple load cases.

Design – Piping
Enhancements Implemented
*
*

Ticket
4855

*

6226

6717

*

6950

CSiPlant v7.0.0

Description
An enhancement was made adding B31.4-2019 as an available design code. Key features
include: Onshore and offshore design checks Local buckling checks API RP 1111 for offshore
piping
An enhancement was made adding B31.1-2020 as an available design code. Key differences
from B31.1-2018 include: Offering of both B31.1 and B31J SIFs in the Design Request
Settings, with B31J set as default. This was done in response to the removal of the
"MANDATORY APPENDIX D FLEXIBILITY AND STRESS INTENSIFICATION FACTORS" in favor of
B31J in the B31.1-2020 design code. Modification of default behavior for axial SIFs: For nondisplacement checks ia = 1.0. For displacement checks, ia = io for tees. Ability to specify
custom SIFs for both displacement and non-displacement checks. Longitudinal stress-check
equations were updated to include axial-force stresses and to separate torsional stresses
from the moment resultant.
An enhancement was made to the options for Flange Leakage checks performed in
accordance with BPVC.VIII.1-UG.44 (formerly Code Case 2901) allowing the user to see
design results in terms of equivalent pressure. The BPVC.VIII.1-UG.44 flange leakage
equation is presented in terms of equivalent pressure P_D*A_f + 4*F/(pi*G^2) +
16*M/(pi*G^3) <= (1 + F_M)*P_R This should facilitate a more direct comparison to flangecatalog rating pressures.
An enhancement was made adding B31.3-2020 as an available design code. Key differences
from B31.3-2018 include: Ability to specify axial SIFs. Default B31J as the method for
calculating Flex/SIF factors.
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*

Ticket
7203

7382

7673

Description
An enhancement was made to the B31.3-2016 and B31.3-2018 design codes to include a
manual calculation for longitudinal stress due to pressure loads. When pressure elongation
is enabled, the contribution to longitudinal stress due to pressure is captured during analysis
and included in the reported axial force. When pressure elongation is disabled, the
contribution to longitudinal stress due to pressure is manually calculated and included in the
total longitudinal stress calculation. Two options exist for manually calculating the
longitudinal stress due to pressure: Approximate the longitudinal stress as 0.5 times the
hoop stress, where the hoop stress is calculated as the Lamé Hoop stress at the inside
surface of the pipe. This method is chosen by specifying Outside diameter in the Design
Preferences. Exactly calculate the longitudinal stress as [(Pi * Di^2)-(Pe*Do^2)]/(Do^2-Di^2).
This method is chosen by specifying Inside diameter in the Design Preferences. For previous
models that already DO have Pressure elongation enabled, there is no change in design
results. Previous models that DO NOT have pressure elongation enabled will display an
increase in longitudinal stress.
An enhancement has been made to the design process whereupon encountering a design
warning, the warning message is added to the Design log and the design continues.
Previously, upon encountering a warning, the design would exit and no design results would
be available for piping that had not yet been designed.
Flange leakage method "Code Case 2901" has been renamed to "ASME BPVC.VIII.1 UG-44"
to reflect the adoption of the code case into ASME BPVC Section VIII. Previous numeric
results are unaffected, but reports and tables will now reflect ASME BPVC Section VIII.

Drafting and Editing
Enhancements Implemented
*

Ticket
211
219
2694

6034

6270
6412

6413
6430
6553

CSiPlant v7.0.0

Description
An enhancement was added to include the option to insert frame objects using the Insert
command.
An enhancement was added to provide feedback to the user when an object cannot be
deleted so that the user is aware of the reason that the delete command was not executed
on selected objects.
An enhancement was added to graphically distinguish valves that have been assigned
eccentric weights. The eccentric weight information is specified using the Define Valve
Properties form. The details of a given valve property can be accessed via the right click
menu on the object.
An enhancement was added to perform a better comparison of nominal pipe diameters with
adjacent component diameters when inserting a new component. Component diameters
are always defined by nominal pipe size (NPS). When the adjacent pipe section is also
defined by NPS, the diameter values are directly compared. When the adjacent pipe section
is defined as a custom value, the closest related NPS value is found, and that value is
compared to the component NPS value. If the values differ, a warning will appear with the
option to continue with the insert or to cancel.
An enhancement was added to the Replicate and Mirror forms to include the option to
select points in the model for determining the offset distance or the mirror plane rather
than typing the numbers directly into the form.
An enhancement was added to inlcude a Rotate command in the Edit menu. The Rotate
command allows the user to define an axis of rotation in the model by specifying two points
or one point and a global-axis direction, and all selected objects are rotated about the axis. If
the rotated objects overlap with existing objects, necessary repair will occur.
An enhancement was added to include the option to graphically display the weight of
components in the model. In the Set Display Options form, a new checkbox for Component
Weights has been added under Flanges/Valves.
An enhancement was added to include multiple object types in the Assign Flanges to Object
Ends form (previously Assign Flanges to Valve Ends). The form now includes the option to
apply flanges to tees, reducers, elbows, and valves.
An enhancement was added to include the option to insert 2-Joint Links using the Insert
command.
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*

Ticket
7621

Description
An enhancement was added to allow the user to calculate elbow bend radii based on the
nominal diameter (NPS) of the pipe rather than the actual diameter. This is controlled by the
"Bend Radius from Nominal Size" setting that can be accessed via command Options >
Default Auto Drafting Options. For older models, the setting will automatically be set to
calculate the elbow bend radius from the actual diameter to remain consistent. For new
models, the default setting will be to calculate the bend radius from the nominal diameter
value. If the setting is changed and there are existing elbows in the model, the change will
automatically be applied to all existing elbows and repair of pipelines will occur as
necessary.

External Import and Export
Enhancements Implemented
*
*

Ticket
6403

Description
An enhancement was implemented allowing for the import of pulsation loads due to
reciprocating pumps and compressors from BOSpulse as a time history load case. The
BOSpulse pulsation loads act on straight pipes between two joints on a pipeline where the
pipeline changes direction and are expressed as harmonic loads for each node pair. Each
harmonic load is defined by a set of frequencies, amplitudes, and phase angles. The import
creates separate sine-series time history functions for each node pair, separate load
patterns for each node pair with unit loads equally distributed to each node of the pair, and
a time-history load case in which the time variable loads for each node pair are
simultaneously applied. Detailed information on the import procedure is available in the
"BOSpulse Loads Import Manual" located in the "Manuals\Import" subdirectory in the main
CSiPlant installation directory.

Graphics
Enhancements Implemented
*
*

Ticket
5115

Description
An enhancement was added to optimize the creation of time history animations. The time
needed to display the animations has been significantly decreased.

Installation and Licensing
Enhancements Implemented
*
*

Ticket
326

*

6501

Description
An enhancement was implemented to update the cloud licensing. This update includes the
ability to checkout a license for offline use, as well as improvements to the general behavior
and making it more fault tolerant. To try out CSiPlant for up to 30 days before purchasing a
license, it is now required to request a trial activation key via the CSI website. Existing
CSiPlant users will be asked to input their licensed CSiPlant activation key again the first time
they run v7 after upgrading through the CSI Customer Center or with their local CSI office.
The version number has been changed to v7.0.0 for a new major release.

Loading
Enhancements Implemented
*

Ticket
5513

CSiPlant v7.0.0

Description
An enhancement was added to preserve the loads on main portion of the tee when the tee
is converted to a straight pipe during element deletion. When a tee is deleted, the tee main
is converted to a straight pipe, and the loads that were previously assigned to the tee are
assigned to the new pipe which is now in its place.
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Results Display and Output
Enhancements Implemented
*

Ticket
6118

Description
An enhancement was added to allow custom filtering of non-numeric columns in any table
display. Columns with non-numeric values can be filtered by "Contains" and "Does Not
Contain" by selecting the Custom Filters menu item after right-clicking on a column header.

Structural Model
Enhancements Implemented
*
*

Ticket
6404

*

6822

Description
An enhancement was added to allow the user to add expansion joints to the model. Three
types of expansion joints are available: Single expansion joints, where all six degrees of
freedom can be assigned a stiffness.Hinge expansion joints, where the user can specify the
axis of rotation as either R2 or R3 and define the stiffness in that degree of freedom, while
all other DOFs are rigid. Gimbal expansion joints, where the user can assign a stiffness in the
R2 and R3 direction, and the rest of the DOFs are rigid. Hinge and Gimbal Joints can also be
defined as Slotted, which allows the user to define the stiffness in the U1 direction. This
enhancement also allows the user to add tie rods to the Simple type expansion joint. Tie
rods can be either Simple, meaning they are designed as a tie or ties from the expansion
joint end to end at the centerline, or Complex, meaning the user can define the offset
distance of the ties from the centerline of the joint.
An enhancement was implemented to model distributed soil supports for pipe elements
following the recommendations described in the "American Lifelines Alliance: Guidelines for
the Design of Buried Steel Pipe, July 2001". The modeling consists of defining soil properties,
defining distributed support properties of type "American Lifelines Alliance Soil", and
assigning the distributed support properties to pipe elements.The continuous support
provided by soil is internally approximated by link elements created at each discretization
point along the pipe. Multi-linear link properties are used to represent the soil forcedeformation response with the points on the force-deformation curve determined based on
soil properties and other parameters per the Guidelines. For time-history analyses, gapping
and non-gapping soil behavior can be specified using the following hysteresis types: (1)
Gapping with Takeda Hysteresis; (2) Non-Gapping with Takeda Hysteresis; (3) Non-Gapping
with Kinematic Hysteresis.The total number of generated link elements created at each
internal discretization point depends on the gapping behavior specified for the axial, lateral,
and vertical directions. For each direction, two links will be generated to represent gapping
behavior, or else a single link will be generated to represent non-gapping behavior.Complete
details are provided in the "Soil Modeling per American Lifelines Alliance" manual accessible
via "Help > Documentation > Documents > Manuals > Soil Modeling per American Lifelines
Alliance".

User Interface
Enhancements Implemented
*
*

Ticket
292
6554
7667

CSiPlant v7.0.0

Description
An enhancement was added to include the option to display elements in the model by color
based on the following categories: object type, section, material, pipe property set, pipeline,
or group. These new options are added as checkboxes on the Set Display Settings form.
An enhancement was added to include Apply and OK buttons on the Insert form. The Apply
button has the same functionality as the previous Insert button which completes the insert,
and the OK button will automatically close the form after the insert occurs.
The Display Information form for elbows has been revised to display Bend Angle (the angle
measuring change of direction of the outgoing pipe relative to the incoming pipe) in
degrees. Previously, the Deflection Angle (half of the difference between a straight angle
and the angle between incoming and outgoing pipe) was displayed in radians.
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Analysis
Incidents Resolved
*

Ticket
5974

6878

*

6879

6949

*

7270

Description
An Incident was resolved when running analysis and design would not run any design
requests when no load cases were selected to be run on the "Set Load Cases to Run" form.
Now selected design requests will be run after first running their prerequisite load cases,
even if no load cases had been explicitly selected.
An incident was resolved when running analysis for a model with distributed supports
assigned to a tee whose branch was shorter than half of the tee main diameter would
generate an error message "An error has occurred while generating the analysis model."
when creating the analysis model. When this occurred, the analysis was terminated and no
analysis results were available.
An incident was resolved where the Poisson contraction/elongation due to internal/external
pressure loading on pipe objects with axial stiffness modifiers was not correct. The
calculated Poisson axial strain was being incorrectly scaled by the inverse of the assigned
axial stiffness modifier.
An incident was resolved where, when changing a load-case type from one that supports
reference temperature and pressure loads (e.g., linear static, nonlinear static, or nonlinear
direct-integration time history) to one that does not support reference loads (e.g., linear
direct-integration time history or linear/nonlinear modal time history), the reference loads
were converted to applied loads but these loads could not be edited or deleted. Now the
converted reference loads can be modified or deleted after changing the load-case type.
Existing analysis and design results are not affected by this change.
An incident was resolved where nonlinear static and staged-construction load cases could
converge with equilibrium errors that were larger than expected when large external loads
were applied. When this occurred, the errors were typically in a direction or region of the
model not significantly affected by the external load. For example, horizontal reactions in
one portion of the model may be out of balance due to large vertical loading in a different
region of the model. The effect of this error was negligible for most models. Now
equilibrium convergence is measured using the relative convergence tolerance times the
magnitude of the internal forces, rather than the previous approach of considering the
larger of the internal and external forces. This change will have no impact on most models,
and will tend to increase iteration and improve equilibrium for other models. A few models
that previously converged may now fail to converge under the tightened equilibrium
requirements; this can usually be resolved by improving the stability or conditioning of the
model. Note that the behavior of the pure event-to-event solution strategy is not affected
by this change, except that the reported equilibrium error could be larger; no other results
will be affected.

Database Tables
Incidents Resolved
*

Ticket
7071

7072

7548

CSiPlant v7.0.0

Description
Various updates were made to the Flange and Valve Assignments Tables: (1) Fixed the
spelling errors in column names in Component Assignments -> Component Flange
Assignments table.(2) Property Definitions -> Components -> Component Properties -> Valve
Table is now shown in the Select Tables form.(3) Eliminated the error shown when the
Component Flange/Valve Assignments Table was opened.
An incident was resolved where specific-gravity values were displayed incorrectly in the Pipe
Contents Property Table when the global units were changed. This did not affect results and
was only shown incorrectly in the table. Specific gravity is dimensionless and now the
displayed value does not change with changes to the global units.
An Incident was resolved where the tables "Joint Loads - Ground Displacements", "Joint
Loads - Force", and "Component Properties - Flange" tables did not have the correct table
name in Excel after exporting.
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Design – Piping
Incidents Resolved
*
*

Ticket
6776

*

6801

*

6965

*

7079

7220

*

7262

CSiPlant v7.0.0

Description
An incident was resolved where the Flange leakage setting to "Ignore flanges in axial
compression" was incorrectly reset to its default value (No) when a saved model was
reopened.
An incident was resolved where changes made to the design stresses for ASTM materials in
the Define Materials form would not be saved after closing the form. Only design stresses
without temperature dependence were affected. Note, all results were consistent with the
design stresses shown when the Define Materials form was first opened and as presented in
the design reports.
An incident was resolved where the error message "ERROR: An exception occurred during
design: The given key was not present in the dictionary" could, on rare occasions, be
displayed during the design. When this occurred, the design was terminated and no design
results were available. This error was related to the calculation of SIF/Flex pressure
correction on elbows, so only models with elbows and pressure correction enabled were
impacted. This error was not common and was difficult to reproduce.
An incident was resolved relating to Flange Leakage checks where the pressure loading used
in the calculation was double-counted if pressure elongation was enabled when the analysis
calculated internal forces in the piping based on the pressures assigned to the pipeline.
These calculations are included in the flange leakage checks inside the Force term, Fe. The
previous behavior also included the assigned pressure via the PD term. The updated
behavior modifies the pressure used in the PD term when pressure elongation is enabled in
the following manner: If the gasket diameter exactly matches the nominal inside diameter,
the PD term is set to zero. If the gasket diameter differs from the nominal inside diameter,
the PD term is multiplied by the scale factor [1-(d/G)^2], where d is the nominal inside
diameter and G is the user specified gasket diameter. The scale factor accounts for the
pressure thrust acting on the portion of the flange between the gasket diameter and the
nominal inside diameter. Previous design results were conservative. It is recommended that
affected models be reanalyzed with the new version.
An incident was resolved where a nonlinear static load case (say, case "B") applying absolute
temperature loads could produce incorrect results if, during the same run, a previous modal
load case was run that used the stiffness from a different nonlinear static load case (say,
case "A"). The effect of this error was reduced when a smaller convergence tolerance was
used for the affected load case "B". The error was caused by the absolute temperature loads
being calculated with respect to the initial state of the case "A" instead of case "B" itself.
This error did not occur if load case "B" was run without the modal load case dependent on
load case "A". This was not common.
An incident was resolved with spring hanger sizing where models containing objects with
flex factors would produce incorrect operating displacements. This was caused by a misordering of the internal staged construction cases responsible for the determination of these
results. Previously, the internal load case chain responsible for the calculation of the
operating displacements would create load cases in the following order: 1) Change the
spring hanger properties to a free support, apply the calculated hot load to the support
joint. 2) Apply flex factors as property modifiers to all tee and elbow objects. However, since
the property modifiers were applied after the hot load, the stiffness of the pipeline did not
incorporate the appropriate flex factors resulting in a structure that was stiffer than
expected. All analysis and design results were consistent with the spring hanger properties
as sized using the operating displacements that did not consider the flex factors. Now, the
internal load case chain is constructed as follows: 1) Apply flex factors as property modifiers
to all tee and elbow objects. 2) Change the spring hanger properties to a free support, apply
the calculated hot load to the support joint. Additionally, an incident was resolved where
anchor stiffness overrides specified for hot load calculation were not being applied in the
correct degree of freedom.

ISO #RELPLA700

17-Dec-2021

Page 6 of 10

*

Ticket
7292

*

7490

7497

*

7737

Description
An incident was resolved where the error message "Message: Unable to set SIF/Flex factor
limits..." was sometimes displayed during the B31J SIF calculations. This could occur when
the SIF/Flex factors calculated during design based on object geometry resulted in a
minimum SIF/Flex factor that was greater than the maximum SIF/Flex factor. The updated
behavior now uses the following rules for the limits:If the calculated SIF/Flex factor is less
than the minimum, the minimum value controls, regardless of the maximum value. If the
calculated SIF/Flex factor is greater than the maximum and minimum but the minimum is
greater than the maximum, the minimum value controls, regardless of the maximum
value.The maximum SIF/Flex factor only controls when the calculated value exceeds the
maximum and the maximum value exceeds the minimum.Note that this situation occurs for
a very specific set of geometry and assignments and is not common.
An incident was resolved that affected displacement stress checks subjected to temperature
scaling. The previous behavior did not apply the temperature scaling to the axial stress
component. Now the temperature scaling factor is applied to all stress components (axial,
flexural and torsion). The effect on results should be small as axial stress is a small
contribution in flexible systems. However, older affected models should be re-designed to
verify whether or not the effect is significant.
An incident was resolved where the Pressure checks of B31.3-2016/2018 only reported the
Centerline and Intrados required thicknesses. Now Centerline, Intrados and Extrados
thicknesses are reported. The DCR calculation only requires the Centerline thickness, so
overall results are unaffected.
An incident was resolved affecting the design of piping using B31.1-2018 where non-default
design properties of pipes or components drawn after opening a previously saved model
would have their design properties overridden and replaced with default values during
analysis and design. After running the analysis and design, inspection of the design
properties for these objects would show the default values. Similarly, review of the design
tables/reports would show the default values. The results of the analysis and design,
although consistent with the values displayed, are in disagreement with the user assigned
non-default values. Previous models may be affected, and the design property assignments
should be reviewed for correctness and reassigned where incorrect properties exist.

Drafting and Editing
Incidents Resolved
*

Ticket
6468

6981

7451

CSiPlant v7.0.0

Description
An incident was resolved addressing the following issues with assigning advanced local axes
to points, frames, and links:(1) When advanced local axes were specified using the Two
Points option, but either or both points were set to None, the software would suddenly
terminate upon assignment.(2) When advanced local axes were specified using the User
Vector option but the user vector was aligned with the axial vector of the object, invalid
local axes were assigned. This resulted in the affected local-axes assignments not being
graphically shown, and could possibly cause invalid analysis results to be produced.(3) When
advanced local axes were specified using the Coordinate Direction option, and both the
primary and secondary directions were aligned with the axial vector of the object, the
software would suddenly terminate upon assignment.For the above rare scenarios, the
advanced local axes are not uniquely defined and cannot be determined due to axial and
plane vectors being aligned. Now valid default local axes will be created in such situations.
An incident was resolved where the Assign Flanges to Object Ends command was inserting
flanges in a direction that was opposite from conventional piping models. The flanges are
now inserted in a direction that assumes the selected object already has one-sided flanges
at both ends. Additionally, a new property was added to valve definitions which allows the
user to specify if the valve is flanged on both ends. This property is purely graphical and does
not affect results.
An incident was resolved that addressed two issues with drafting: (1.) Snapping to elbow TIP
was not available in user-defined coordinate systems. (2.) The graphical representation of
the measure tool was incorrect in user-defined coordinate systems. The measured values
were previously correct, and only the graphical display was incorrect.
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*

Ticket
7699

Description
An incident was resolved where reducers and components that were drawn at an angle from
the previous pipe were not replicated properly, but were instead drawn parallel to the
previous pipe. Now the proper angle is retained during replication.

External Import and Export
Incidents Resolved
*

Ticket
6941

7014

Description
The following incidents were resolved when using a Windows regional setting that utilized a
number format with a comma decimal separator: Importing CAESAR CII Neutral files failed
without creating any entities in CSiPlant and without displaying any warning messages in the
import log. Importing PCF files failed without creating any entities in CSiPlant and without
displaying any warning messages in the import log. Creating new CSiPlant model via "File >
New Model..." failed to create new model and no warning message were displayed. Opening
existing CSiPlant model via "File > Open Model..." failed to open the model and no warning
messages were displayed.
An incident was resolved that corrected the following issues for the PCF import: (1.) Blank
lines may have previously prevented the model from being imported from a PCF file.
Unexpected blank lines in the PCF file are now ignored. (2.) The ITEM-DESCRIPTION material
attribute can now be imported, which resolves an issue with the PCF file not being
successfully imported when material-mapping XML files were used.

Graphics
Incidents Resolved
*

Ticket
280

Description
An incident was resolved where the command File > Capture Picture > Current Window w/
Title Bar always took a picture of the first model view instead of the current model view.

Loading
Incidents Resolved
*
*

Ticket
6946

7655

CSiPlant v7.0.0

Description
An incident was resolved where the pressure load contour was not correctly displayed on
the branch portion of a tee element. Additionally, during the analysis of tees which had been
assigned any loads, the portion of the tee branch that was within the tee main (i.e., from the
tee main centerline to the outer edge of the tee main) was loaded with the assigned loads
causing a redundancy. This portion of the tee branch no longer contributes loads to analysis
results. This could effect the results of previously run models which contained tee elements.
An Incident was resolved where the program-calculated exposure height minimum and
maximum Z coordinates for the ASCE/SEI 7-10 and ASCE/SEI 7-16 auto lateral wind load
patterns would be unrealistically large values when there were no objects in the model.
Also, a warning message "The ground global Z value must be less than or equal to the min
global Z value." was displayed when attempting to save the Wind Load Parameters form
with default parameters that include Ground Global Z coordinate of 0. Now, the exposure
height minimum and maximum Z coordinates are set to 0 when there are no objects in the
model, and the form can be saved without any warning messages when default parameters
are used.
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Structural Model
Incidents Resolved
*

Ticket
6262

6984

Description
An incident was resolved where the function data points of directional properties for R1, R2,
and R3 of multilinear links and supports were displayed with the incorrect units. This led to
an incorrect conversion of the data points when the program global units were updated.
This can affect multilinear links in models made in older versions where the global units
were set to anything other than inches and pounds, and these links should be checked
before proceeding with these older models.
An incident was resolved where the NPS value of pipe sections, flanges and valves was
incorrectly converted when metric units were selected as the global display units. If a metric
units are selected, this property is now displayed as a DN (Diametre Nominel, mm) value.
This was a display issue only. Results were not affected.

User Interface
Incidents Resolved
*

Ticket
375

6731
6982

7090
7264

CSiPlant v7.0.0

Description
An Incident was resolved where the nonlinear damping coefficient of the exponential
damper was treated as unitless instead of having the actual units of "Force *
(Sec/Length)^Cexp" units, where Cexp is the nonlinear damping exponent. Hence the value
of this coefficient was not being converted for changes in units. Now, the correct units
conversion is performed on display forms, when reviewing the nonlinear exponential
damper properties in tables, and when adding another CSiPlant model with different units
to an existing CSiPlant model. The correct label for the units is also now displayed on display
forms.When opening or adding older models (i.e., models saved in a version prior to v7.0.0),
the value of nonlinear damping coefficient stored as a unitless value in the old model file is
read in and assigned the "Force * (Sec/Length)^Cexp" units, where the Force and Length
units are the actual database units of the model being opened or added. Note that database
units are "lb, in, F" for models initialized with U.S. Customary units, "mm, N, C" for models
initialized with Metric SI units, and "mm, kgf, C" for models initialized with Metric MKS units.
These database units might be different from display units shown in the lower right corner
of the main window. When display units are different from database units, the damping
coefficient values shown on the forms will be different from the values shown in the old
model file, because the units conversion described below is now performed to convert from
database units to display units. Since the analysis model is created in database units, analysis
and design results for the model analyzed in current version will match the analysis results
obtained from versions prior to 7.0.0.After the old model has been opened in the new
version, any subsequent units conversions for the nonlinear damping coefficient will be
performed using the "Force * (Sec/Length)^Cexp" units.It is strongly recommended to
review values of the nonlinear damping coefficients after opening or adding older models.
An incident was resolved where no load assignments would be displayed for time history
load cases when displaying using the "Display > Load Assignments" menu command. No
results were affected.
An incident was resolved where the units of rotational stiffness were labeled as J/rad when
they should have been labeled as N*m/rad. The affected properties can be found in the
Define Links form, Define Supports form and the Modal Participation Factors table. This
change is purely cosmetic and does not affect results.
An incident was resolved where the measure tool could not be used on a locked model that
was closed and then re-opened.
An Incident has been resolved where the Stiffness Type combination box on the "Assign
Anchor Stiffness Overrides" form contained entries "a", "b" and "c" in the drop-down list.
This has been corrected to show the correct entries "Fixed", "Free" and "Linear" entries.
Note that selecting "a", "b" or "c" in the previous version had the same effect as choosing
"Fixed", "Free", or "Linear" in the current version, respectively.
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*

Ticket
7411

7412

CSiPlant v7.0.0

Description
An incident was resolved where an error message stating "Insufficient room to
accommodate valve" was occasionally shown when valves were edited, even if the valve
length was not changed. This occurred when a valve property definition was changed in the
Define Valves form, which caused the existing valves in the model to be updated for valve
length changes. Due to a slight difference in tolerances when drafting the valve and
updating the valve, the error message was displayed despite the length of the valve
remaining constant. The tolerances have been updated which has resolved the problem that
caused this incident.
An incident was resolved that addressed two errors that occurred while editing the flange
pressure rating data points: (1.) When the user edited a value and then used the Enter key
to finish editing, duplicate values were allowed in the data table, which then caused an error
and forced the form to close. Now the Enter key no longer ends editing of the cell and does
not create an additional row of data points. (2.) When the data values contained multiple
decimal points, this created a rounding error that led to the Add and Delete keys not
working properly.

ISO #RELPLA700

17-Dec-2021

Page 10 of 10

